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Thank you for using SC-LG-CEF Configuration Tool.
SC-LG-CEF Configuration Tool is an application that can collect measurement data from Pan-
asonic IO-Link master SC-LG2-CEF-P and IO-Link devices connected to the IO-Link master, 
set up various parameters, and load data.

Notes

1)	 No part of this manual may be reproduced or reprinted in any form or by any means without 
prior written permission from Panasonic.

2)	 The contents of this manual are subject to change without notice for future improvement.
3)	 This manual has undergone strict quality control; but should you discover any dubious infor-

mation, mistakes, misplaced pages, or missing pages, please contact your local dealer.
4)	 CC-Link IE Field is a registered trademark of Mitsubishi Electric Corporation and a trademark 

managed by CC-Link Partner Association.
5)	 GX Works3 is a registered trademark or trademark of Mitsubishi Electric Corporation.
6)	 Windows is a registered trademark or trademark of Microsoft Corporation in the United States 

and/or other countries.
7)	 Ethernet is a registered trademark of FUJIFILM Business Innovation Corp..
8)	 IO-Link is a registered trademark of PROFIBUS User Organization.
9)	 The ownerships of all other trademarks belong to their respective owners.
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Manual Configuration

1 Before Using This Product
This chapter explains the terminology, the functions of this 
software tool, the software license agreement for the soft-
ware tool.

2 Preparation This chapter explains the system environment, system 
overview, and connections.

3 �Name and Function of 
Each Window

This chapter explains the name and function of each con-
figuration window.

4 Other Functions
This chapter explains the master addition, removal, and as-
signment functions, project creation and saving functions, 
network number setting function, and other functions.

5 Messages This chapter explains confirmation dialog boxes.
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1.1 Handling Precautions
■The following symbols are used to indicate safety information that must be observed.

Indicates an action that is prohibited.

Indicates an action that must be taken.

Indicates a matter that requires caution.

Information Indicates supplemental information.

Reference Indicates reference to details about the subject in question.

Caution
Indicates points to be noted when the product is operated.

1.2 Terminology
Term Description

CC-Link IE 
Field related

Master station A station that controls the entire network. This station can perform cyclic 
transmission and transient transmission to all stations.

Slave station
A generic name of all stations other than master stations (local stations, 
remote I/O stations, remote device stations, and intelligent device sta-
tions)

SC-LG2-CEF-P
An IO-Link master compliant with CC-Link IE Field.
This master connects IO-Link devices using e-CON connectors.
PNP connection is based on the I/O interface specifications of IO-Link 
devices.

CC-Link IE Field net-
work

A high-speed and large-capacity open field network using Ethernet 
(1000BASE-T)

Cyclic transmission A function that periodically exchanges data between stations on the 
same network in the data link layer

Transient transmission
A function that uses the read/write instructions of the program at the lo-
cal station to read and write data from / to remote stations and commu-
nicate with remote stations via peripheral devices in the data link layer

Memory map
A memory map where the functions of the communication unit are al-
located to link devices. The master station can use the functions of 
the communication unit by accessing the link devices allocated on the 
memory map.

Link device Internal devices held by the unit (RX, RY, RWr, and RWw)

Network number
A unique number that is assigned to identify each network when mul-
tiple networks are created.
Duplicate numbers cannot be set among all networks.

Station number
A unique number that is assigned to identify each network unit that is 
connected to a network.
Duplicate numbers cannot be set among all network units within a net-
work.

Intelligent device sta-
tion

A station that cyclically transmits bit-based I/O signals and word-based 
I/O data to the master station. This station returns responses to tran-
sient transmission requests from other stations.
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Term Description

IO-Link re-
lated

Process data (PD) Cycle data. Process data is automatically transmitted during normal op-
eration.

IEC 61131-9
One of the international certifications handling PLC standards that spec-
ifies an I/O connection technology standardized for communication with 
sensors or actuators

IODD Describes the device's own information and settings

IO-Link A digital communications protocol that connects sensors or actuators to 
remote I/O, PLC, etc.

IO-Link device Performs one-to-one and point-to-point IO-Link communications with 
the IO-Link master

IO-Link master Plays a role as a gateway to transfer data between each IO-Link device 
and each of the systems connected to high-level buses

Port An IO-Link communication channel port

1.3 Overview
SC-LG-CEF Configuration Tool has the following functions.

	● IO-Link master detection function
This function detects IO-Link master SC-LG2-CEF-P on the CC-Link IE Field network via a 
programmable controller (PLC).

	● IO-Link master port configuration function
This function configure a port for IO-Link master SC-LG2-CEF-P that is detected.

	● Function for communicating with IO-Link devices via IO-Link master
The following processing can be performed on IO-Link devices connected to IO-Link master 
SC-LG2-CEF-P that is detected.
• Reading process data from IO-Link devices and setting some data
• Monitoring the IO-Link device detection status
• Checking diagnosis information for IO-Link devices

	● Other functions
Project saving function, language switching function, and other functions
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1.4 Software License Agreement
Panasonic Industrial Devices SUNX Co., Ltd. (“PIDSX”) grants to you a license to use this Soft-
ware on condition that you accept this Agreement. You must read this Software License Agree-
ment (this “Agreement”) carefully before using this Software. Only in case that you accept this 
Agreement, you may start your use of this Software.
Your unsealing the package of this Software, or your downloading, installing or launching this 
Software or the like shall be deemed as your acceptance of this Agreement.
The Software includes not only proprietary computer programs owned by or licensed by PIDSX 
but also open source software programs. As for the open source software programs, refer to the 
detailed terms and conditions thereof shown in the installation package of the Software. Should 
a discrepancy arise between any of the terms of this Agreement and any open source software 
program license statement, the open source software program license statement shall take pre-
cedence over this Agreement.

Article 1	 Grant of License
PIDSX hereby grants to you a non-exclusive license to use this Software only in com-
bination with PIDSX product(s) specified in the manual of this Software (the “Product”) 
in accordance with the terms of this Agreement. You may not use this Software in con-
nection with products of any third party other than PIDSX.

Article 2	 Restrictions
You may NOT:
(1)	 Modify, reverse engineer, decompile, or disassemble this Software,
(2)	 Use this Software by methods or for purposes other than those specified in the 

manual of this Software provided by PIDSX, nor
(3)	 Distribute, rent, lease or otherwise transfer this Software to any third party; pro-

vided, however, that you may assign the rights to use this Software under this 
Agreement along with the Product on the condition that the assignee agrees to 
be bound by all the terms of this Agreement. In the case of such assignment, you 
must deliver any and all the copies of this Software and all the accompanying ma-
terials to the assignee and you may not retain any copies of this Software includ-
ing backups.

Article 3	 Disclaimer
3-1.	PIDSX MAKES NO WARRANTY OR REPRESENTATION OF ANY KIND, EXPRESS, 

IMPLIED OR STATUTORY, WITH RESPECT TO THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS.

3-2.	UNDER NO CIRCUMSTANCES SHALL PIDSX BE LIABLE FOR ANY DAMAGES 
(INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR SPECIAL 
DAMAGES WHATSOEVER) ARISING OUT OF THE USE OF THIS SOFTWARE, IN-
ABILITY TO USE THIS SOFTWARE, DEFECTS IN THIS SOFTWARE (e.g., BUGS, 
SECURITY HOLES, AND MALFUNCTION), OR OTHERWISE IN CONNECTION 
WITH THIS SOFTWARE.

Article 4	 Term
4-1.	This Agreement shall come into effect upon your unsealing the package of this Soft-

ware, or your downloading, installing or launching this Software or the like.
4-2.	PIDSX may terminate this Agreement immediately, if you breach any of the provisions 

of this Agreement.
4-3.	You shall, at your own costs, return, delete or destroy this Software and any of its cop-

ies within four (4) weeks after termination of this Agreement.
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Article 5	 Export Control
You shall comply with all laws and regulations regarding export control under any 
competent jurisdiction, including but not limited to the Japanese Foreign Exchange 
& Foreign Trade Control Law, the export control regulations based on resolutions of 
the United Nations Security Council, etc. If any license or appropriate approval from a 
governmental authority is required under the applicable laws, you may not export this 
Software without such approval to any countries either directly or indirectly. Further-
more, you shall neither use nor sell this Software for military purposes either directly or 
indirectly.

Article 6	 Intellectual Property Rights
Except the open source software program, all intellectual property rights in this Soft-
ware, including the copyright, belong to PIDSX and/or the licensors of PIDSX.

Article 7	 Upgrade of this Software
7-1.	Release of future upgrades or updates of this Software is not guaranteed and left to 

the sole discretion of PIDSX.  Furthermore, PIDSX may charge fees for upgrading or 
updating of this Software.

7-2.	If any upgrades or updates are provided to you either for fees or for free, such up-
grades or updates shall be deemed as a part of this Software and shall be governed 
by this Agreement, unless PIDSX designates otherwise at the time of provision of such 
upgrades or updates.

Article 8	 Limitation on Liability
AGGREGATE LIABILITIES OF PIDSX IN CONNECTION WITH THIS AGREEMENT 
OR THIS SOFTWARE SHALL IN NO EVENT EXCEED TEN THOUSAND (10,000) 
YEN.

Article 9	 Governing Law and Jurisdiction
9-1. 	This Agreement shall be governed by the laws of Japan.
9-2.	Should any dispute arise from or in connection with this Agreement, Nagoya District 

Court, Japan shall exclusively have jurisdiction over such dispute.

This Software consists of the following types of software.
(1)	 Software developed independently by PIDSX
(2)	 Software owned by a third party and licensed to PIDSX
(3)	 Open source software licensed on conditions of such open source software
PIDSX makes no warranty, including implied warranties of merchantability and/or fitness for par-
ticular purpose to software in category (3) above. For details, Please refer to the detailed terms 
and conditions thereof shown in the installation package of this Software.
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2.1 System Environment
SC-LG-CEF Configuration Tool operates in the following system environment.

	● Compatible operating systems:
Microsoft® Windows® 10 Pro 32bit, 64bit

	● Processor: Atom 1.33GHz or faster processor
	● Memory: 2GB minimum
	● Display: 1,024 × 768 or higher resolution with at least 256 colors
	● Interface: 1Gbps
	● Hard disk: Maximum 500MB free space required
	● CD or DVD drive: Not required
	● .NET Framework 4.6.2 onwards

Download and install .NET Framework from Microsoft® download center if it is not already installed.
	● Microsoft Visual C++ 2017 SP1

Redistributable Package (x86) must be installed separately.
	● Adobe Reader

To display the Manual from the Help menu, Adobe Reader must be installed separately.
	● Programmable controller (PLC) and CC-Link IE Field master unit
	● GXWorks3

GXWorks3 must be installed separately because SC-LG-CEF Configuration Tool controls 
SC-LG2-CEF via sequencer manufactured by Mitsubishi Electric Corporation.

Reference

For information about compatible PLCs and CC-Link IE Field master units, refer to the website of 
CC-Link Partner Association (https://www.cc-link.org/en/).
The following models have been tested and confirmed to connect properly as of December 2021.

• QJ71GF11-T2
• LJ71GF11-T2
• RJ71EN71
• RJ71GF11-T2
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2.2 System Overview
This system enables SC-LG-CEF Configuration Tool to transfer measured values and other 
data from IO-Link devices (such as sensors) via a programmable controller (PLC) and CC-Link 
IE Field network.
The main functions of the system are the IO-Link master setup function and the IO-Link device 
data monitoring / setting function.

2.2.1 System Connection Diagram

This system is explained as below.

IO-Linkデバイス

IO-Linkマスタ

CCIEF
Master

CPU

PC

PLC

 
The PC and PLC are connected with an Ethernet or USB cable.
The SC-LG2-CEF-P is used as IO-Link masters.
IO-Link devices including other manufacturers' products are used as IO-Link devices. The IODD 
file associated with each IO-Link device must be imported into SC-LG-CEF Configuration 
Tool.

Caution

	● Download the IODD files from the website of the IO-Link device manufacturer or the  
IODDfinder website (https://ioddfinder.io-link.com/).

	● The IODD files of Panasonic IO-Link devices can be downloaded from our website  
(https://panasonic.net/id/pidsx/global).

IO-Link masters

IO-Link devices
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2.3 Setup on the Programmable Controller (GX Works3) Side
This section explains how to set up parameters for IO-Link master SC-LG2-CEF-P.
The parameter setting method differs according to the master station unit.
The parameter setting method is explained below, using Mitsubishi Electric Corporation's 
RJ71EN71 as an example.

Reference

For details, refer to the instruction manual of the master station unit that you use.

	●  Example of RJ71EN71(CCIEF) unit parameter settings
Station type: Master station
Network No.: 1

<Network configuration settings>
Station number: 1
RX / RY settings (starting / ending): 1000 / 106F
RWw / RWr settings (starting / ending): 1000 / 1083

<Refresh settings>
Link side CPU side

Device 
name

Starting 
address

Ending 
address

Device 
name

Starting 
address

SB 00000 001FF SB 00000
SW 00000 001FF SW 00000
RX 01000 0106F X 01000
RY 01000 0106F Y 01000
RWr 01000 01083 W 01400
RWw 01000 01083 W 00400
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	● Setting up RJ71EN71(CCIEF) unit parameters
Set up parameters in the engineering software (GX Works3) at the master station.

1.	 In the Navigation window, select Module Information and then RJ71EN71(CCIEF).

Reference

For details on how to set up the master station, refer to the instruction manual of the master station 
unit that you use.

2.	 Set up the contents of Required Settings for module parameters as shown below.
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3.	 Double-click <Detailed Setting> in Network Configuration Settings.

4.	 The CC IE Field Configuration dialog box will be displayed.
In the Module List, select SC-LG2-CEF-P under CC IE Field Module (Panasonic Indus-
trial Device SUNX) and drag and drop it into the station list or network configuration diagram. 
SC‑LG2‑CEF‑P will be added.

Station list

Network  
configuration 
diagram

Drag and drop

If CSP+ for SC-LG2-CEF-P has not been registered, "SC-LG2-CEF-P" will not be displayed 
in the Module List. Register CSP+ in advance.
If CSP+ for SC-LG2-CEF-P cannot be registered, use and set CSP+ for general intelligent 
device stations.

Reference

For information about how to download CSP+, refer to the SC-LG2-CEF-P User's Manual (our web-
site: https://panasonic.net/id/pidsx/global).
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5.	 Set up a CC IE Field configuration as shown below.

6.	 After setting up the configuration, click the Close with Reflecting the Setting menu to close 
the CC IE Field Configuration dialog box.
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7.	 Double-click <Detailed Setting> in Refresh Settings.

8.	 A refresh parameter setting window will be displayed. Specify settings as below.
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3.1 Operating Procedure
The procedure for operating SC-LG-CEF Configuration Tool is shown below.

Notes: 1)	 If the Auto Login check box in the Option window is selected, the Login window will not be displayed.
	 2)	 When starting SC-LG-CEF Configuration Tool for the first time, set a network number to add an IO-

Link master for which no network number has been set.

Reference section

“3.2 Login Window”Login (Note 1)

Log in to SC-LG-CEF Configuration Tool.

“3.3 Start Window”Start

Select appropriate start options for SC-LG-CEF Configuration 
Tool.

“3.4.1 Master Port Configuration”Configuring IO-Link master ports

Configure each port for the IO-Link master.

“4.8 Network Number Setting Function”Setting a network number (Note 2)

Set a network number for the IO-Link master.

“3.4.2 Select Device Window”Selecting IO-Link devices

Select IO-Link devices connected to the IO-Link master.

“3.5 Master Information Window”
“3.6 Device Monitoring Window”
“3.7 Device Setup Window”
“3.8 Device Diagnosis Window”
“3.9 Device Information Window”

Specifying various settings and displaying information

Display device information for the IO-Link master, set up IO-
Link devices, and display diagnosis and device information 
and graphs for IO-Link devices.

“4.6 Project Saving Function”
“4.10 Exit Function”Saving the projects and closing the tool

Save various settings and changed projects and close 
SC‑LG‑CEF Configuration Tool.
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3.2 Login Window
In the Login window, log in to the tool by entering the password corresponding to the user au-
thority of SC-LG-CEF Configuration Tool.
When SC-LG-CEF Configuration Tool starts, the Login window is displayed only if the Auto 
Login check box in the Option window is not selected.

1
2

3 4
Name Description

1 User Administration
Select an appropriate user authority from Operator, Maintenance, and Spe-
cialist. After login is completed, information in the IODD file corresponding 
to the selected user authority will be displayed.

2 Password

You can enter the password corresponding to each user authority.
A password that you enter is displayed as black dots (●).
The default password is unset. You can change a password in the Option 
window.

3 Login
Clicking this button displays the main window if the user authority and the 
password match.
If they do not match, you cannot proceed to the next window even if you 
click the Login button.

4 Exit Clicking this button closes SC-LG-CEF Configuration Tool.

Reference

For details on how to set a password, refer to “3.10 Option Window”.
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3.3 Start Window
This window is used to select appropriate start options and start SC-LG-CEF Configuration 
Tool.

1
2
3

4

5
Name Description

1 New Select this option to set up a new IO-Link master or IO-Link device offline.
2 Open Select this option to open the file of a project that has been set up before.

3 Load from Master
Select this option to load data from an IO-Link master that is connected to 
the PC via a PLC.
When this option is selected, the "Connecting IO-Link Master" area can be 
manipulated.

4 Connecting IO-Link Master

A list of IO-Link masters that are connected to the PC via a PLC is dis-
played.
You can select a desired IO-Link master by selecting the check box on the 
top left of the frame of the device.
The product name and connecting information [NNo. (network No.), SNo. 
(station number)] are displayed. Select the check box on the top left of the 
frame of the master that you want to set up.
By clicking the Select All check box, you can select or cancel all the IO-Link 
masters that are displayed.

5 Start

After selecting New, Open, or Load from Master, click this button to start 
SC-LG-CEF Configuration Tool.

	● If you select New and then click the Start button, you will be prompted to 
select the IO-Link master to be added.

	● If you select Open and then click the Start button, the previously set con-
ditions will be displayed.

	● If you select Load from Master and then click the Start button, the data 
of the selected IO-Link master(s) will be loaded. If none of the connected 
IO-Link masters is selected, the Start button will be grayed out.

Reference
For information about how to add IO-Link masters offline, refer to “4.1 Master Addition Function”.
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3.4 Master Port Configuration Window
3.4.1 Master Port Configuration

This window is used to display and set up each port of the IO-Link master selected in the tree 
on the left side of the window.
If you select an IO-Link master in the tree, a master port subwindow will be displayed in the Port 
Setting tab.

1

4 5

2 3

68 9 7
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Name Description

1 Detect Devices
Clicking this button changes the settings of all the ports to IO-Link mode 
and detects the IO-Link devices connected to the selected IO-Link master.
If the selected IO-Link master is unconnected the Detect Devices button 
will be grayed out.

2 Write
Clicking this button writes the current port configuration to the selected IO-
Link master.
If the selected IO-Link master is unconnected, the Write button will be 
grayed out.

3 Read
Clicking this button reads the port configuration from the selected IO-Link 
master.
If the selected IO-Link master is unconnected, the Read button will be 
grayed out.

4 Mode

You can change the port mode for each port of the selected IO-Link master.

	● Inactive: Select this option when you use no port.
	● DI: Select this option when you use the port in DI mode.
	● DO: Select this option when you use the port in DO mode.
	● IO-Link: Select this option when you use the port in IO-Link mode.

If you select IO-Link, in the Select Device window, you must select the IO-
Link device to be connected.
The IO-Link device list is configured using the IODD files that are imported.

5 Device / Vendor
The Device and Vendor columns display product names and vendor 
names, respectively, for IO-Link devices that are connected.
To change the IO-Link device, click the  button.
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Name Description

6 Validation & Backup

If you select IO-Link in the Mode column, you can select the validation level 
and data storage mode as below.

	● No Check:
No IO-Link device validation or data storage is performed.

	● Compatible V1.0 device, No Data Storage:
Vendor ID and device ID are validated for V1.0 IO-Link devices. No data 
storage is performed.

	● Compatible V1.1 device, No Data Storage:
Vendor ID and device ID are validated for V1.1 IO-Link devices. No data 
storage is performed.

	● Compatible V1.1 device, Backup & Restore:
Vendor ID and device ID are validated for V1.1 IO-Link devices. For data 
storage, both backup and restoration are performed.

	● Compatible V1.1 device, Restore:
Vendor ID and device ID are validated for V1.1 IO-Link devices. For data 
storage, only restoration is performed.

7 PD Size IN / PD Size OUT
(Process data size IN / OUT)

If you select IO-Link in the Mode column, you can select process data size 
(IN / OUT). (Input range: 0 to 32)

	● For both PD Size IN and PD Size OUT, you cannot set "0".
	● If the values of PD Size IN and PD Size OUT are different, the size will 
be set to the larger value. (For example, if the value of PD Size IN is 4 
and the value of PD Size OUT is 0, both values will be set to 4.

8 Add Clicking this button adds a new IO-Link master to the tree.
9 Delete Clicking this button deletes the selected IO-Link master from the tree.

Information

By right-clicking with a port selected, you can copy and paste all the settings of the port.

Reference

For details on how to change devices, refer to “3.4.2 Select Device Window”.
For details on how to add IO-Link masters, refer to “4.1 Master Addition Function”.
For details on how to delete IO-Link masters, refer to “4.2 Master Removal Function”.
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3.4.2 Select Device Window

This window allows you to select the IO-Link device to be connected to the IO-Link master.
Clicking the  button in the master port configuration window displays the Select Device window.

1
5

6

2
3

4

7 8 9
Name Description

1 Vendor

IO-Link devices in the device list can be narrowed down to the IO-Link de-
vices of the vendor that you select.

	● All: Displays the IO-Link devices of all vendors
	● Favorite: Displays only the IO-Link devices specified as favorites
	● Latest: Displays only the IO-Link devices that have been used lately

2 IO-Link Revision

IO-Link devices in the device list can be narrowed down according to the 
version of IO-Link devices.

3 Search IO-Link devices in the device list can be narrowed down to only the prod-
ucts whose product names match the string that you enter.

4 Device Family IO-Link devices in the device list can be narrowed down to the IO-Link de-
vices of the product family that you select.
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Name Description

5 Display method switching 
function

The device list display method can be changed.

	● Details: Displays IO-Link devices in detail

	● List: Displays only IO-Link device names and vendor names

6 Device list This area displays IO-Link devices that match the search criteria specified 
in Vendor, IO-Link Revision, Search, or Device Family.

7 Delete
Clicking this button deletes the IODD file included in the IO-Link device se-
lected in the device list.
A confirmation dialog box is displayed before the IODD file is deleted. If 
"Yes" is selected, the IODD file will be deleted.

8 Assign Clicking this button determines the IO-Link device selected in the device 
list and returns the display to the master port configuration window.

9 Cancel Clicking this button returns the display to the master port configuration win-
dow without determining the IO-Link device.
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3.5 Master Information Window
This window displays device information for the IO-Link master selected in the tree on the left 
side of the window.
If you select an IO-Link master in the tree, a master information subwindow will be displayed in 
the Information tab.

1

2
Name Description

1 Label You can assign a name to the device selected in the tree. The assigned 
name will be reflected in the tree.

2 Network No. Setting Clicking this button displays the window for changing the network number 
of the IO-Link master.

Reference
For details on how to change network numbers, refer to “4.8 Network Number Setting Function”.
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3.6 Device Monitoring Window
This window is used to monitor process data for the IO-Link device selected in the tree on the 
left side of the window.
If you select an IO-Link device in the tree, a device monitoring subwindow will be displayed in 
the Monitor tab.

Digital graph Analog graph

2

1 3 4 5 6

7

Name Description

1 Update cycle

You can set an update cycle at which a graph is drawn. (Unit: ms)

2 Operation You can replay, pause, or stop graph drawing.

3 Analog - Item You can select analog items for which graphs are to be drawn.
Items that you can select are analog items of process data for IO-Link devices.

4 Analog - Upper / Lower You can set the upper and lower limit values for analog items for which graphs 
are to be drawn.

5 Analog - Custom You can set up a bar of custom values on the graph.

6 Digital - Item You can select digital items for which graphs are to be drawn.
Items that you can select are digital items of process data for IO-Link devices.

7 Graph drawing area
Graphs are displayed by reflecting the settings in "Update cycle", "Operation", 
"Analog - Item", "Analog - Upper / Lower", "Analog - Custom", or "Digital - 
Item".
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3.7 Device Setup Window
This window is used to set up parameters for the IO-Link device selected in the tree on the left 
side of the window.
If you select an IO-Link device in the tree, a device setup subwindow will be displayed in the 
Set tab.

1 3 4 5

2

Name Description

1 Process data display area
Process data items are displayed according to the information in the IODD 
file of the IO-Link device selected in the tree. The values obtained from the 
selected device are displayed as the values of the process data items.

2 Parameter display area

Parameters are displayed according to the information in the IODD file of 
the IO-Link device selected in the tree.

 buttons are arranged for each item, so that individual items can be 

loaded.
If the user changes the value of an item, a red asterisk (*) will be displayed 
at the beginning of the item.

3 Write Clicking this button writes the parameter value(s) changed in the parameter 
display area to the IO-Link device.

4 Read Clicking this button reads all the parameter values in the parameter display 
area from the IO-Link device.

5 Write Auto

If this check box is selected, when the value of any parameter displayed 
in the parameter display area is changed, the value will be immediately re-
flected in the IO-Link device.
If this check box is not selected, when the value of any parameter dis-
played in the parameter display area is changed, the value will not be re-
flected in the IO-Link device until the Write button is clicked.
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3.8 Device Diagnosis Window
This window displays diagnosis information for the IO-Link device selected in the tree on the left 
side of the window.
If you select an IO-Link device in the tree, a device diagnosis subwindow will be displayed in the 
Diagnosis tab.

1
2
3

4
Name Description

1 Status The status of the current IO-Link device is displayed.
The status is Normal, Notification, Caution or Abnormal.

2 Status details

Details are displayed when the status is Notification, Caution, or Abnormal.
	● Notification:
Measurement error, reduced amount of entering light, unstable entering 
light, or applied voltage during zero-point adjustment

	● Caution:
Operating time limit exceeded or nonvolatile memory saving count limit 
exceeded

	● Abnormal:
DC output short-circuit, nonvolatile memory error, or damaged LED cir-
cuit

3 Operating Time The amount of IO-Link device operating time is displayed.
4 Stored Count The number of write operations to the IO-Link device is displayed.

Information

The Diagnosis tab is displayed only when a Panasonic IO-Link device is selected.
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3.9 Device Information Window
This window displays device information for the IO-Link device selected in the tree on the left 
side of the window.
If you select an IO-Link device in the tree, a device information subwindow will be displayed in 
the Information tab.

1

Name Description

1 Label You can assign a name to the device selected in the tree.
The assigned name will be reflected in the tree.
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3.10 Option Window
This window allows you to set options for SC-LG-CEF Configuration Tool.
Selecting Option from the File menu displays the Option window as a pop-up window.

1

2

3 4
Name Description

1 Login Setting

You can set up auto login and specify a user authority and password that 
are required for auto login.

	● You can specify a user authority and password only when you select the 
Auto Login check box.

	● If you select the Auto Login check box, you must specify a user authority 
and password. In this case, the Login window will be omitted when the 
tool starts.

2 Password of User Administra-
tion You can specify a password for each user authority.

3 OK Clicking this button saves the setting changes and closes the window.
4 Cancel Clicking this button closes the window without saving the setting changes.
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3.11 Version Information Window
This window displays version information for SC-LG-CEF Configuration Tool.
Selecting Version from the Help menu displays a pop-up window that shows the version infor-
mation.
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4.1 Master Addition Function
This function adds a new IO-Link master to the tree.
Clicking the Add button under the tree displays the Adding a Master window.

1

2

3 4
Name Description

1 Create a new Master
A list of IO-Link masters is displayed. By selecting an IO-Link master in the 
Create a new Master tab and then clicking the Add button, you can add the 
IO-Link master in an offline state to the tree.

2 Connecting IO-Link Master
A list of IO-Link masters connected to the PC is displayed.
You can select a desired IO-Link master by selecting the check box on the 
top left of the frame of the device.
By selecting the Select All check box, you can select all the IO-Link masters.

3 Add Clicking this button adds an IO-Link master to the tree.
4 Cancel Clicking this button closes the Adding a Master window.
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4.2 Master Removal Function
This function removes the selected IO-Link master from the tree.
Clicking the Delete button under the tree displays a confirmation dialog box and clicking the OK 
button removes the selected IO-Link master from the tree.

Information

If an IO-Link device is selected in the tree, the Delete button will be grayed out.

4.3 Master Assignment Function
This function assigns the selected IO-Link master (in an offline state) to the actual IO-Link mas-
ter.
Clicking the connection icon of an IO-Link master in an offline state in the tree displays a dialog 
box.

The dialog box displays IO-Link masters that are connected. Select an IO-Link master that you 
want to assign.
By clicking the Assign button with the IO-Link master selected, you can reflect the settings of 
the IO-Link master (that you set up offline) into the actual IO-Link master.

Information

The settings of IO-Link devices that you set up offline cannot be reflected by assignment process-
ing.
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4.4 Device Settings Copy / Paste Function
This function enables you to copy and paste the settings of the IO-Link device that you select.
By selecting and right-clicking an IO-Link device in the tree, you can copy and paste the settings 
of the IO-Link device.

Executing the Copy function causes the frame of the target IO-Link device to blink.

After copying, if you select the same device and execute the Paste function, the settings of the 
selected IO-Link device will be replaced with the settings of the copy source. You cannot paste 
the settings to any IO-Link device that differs from the copy source.
The copy / paste function can be executed by selecting Copy and Paste from the Edit menu or 
using the shortcut keys.

4.5 Project Creation Function
This function creates new projects.
Selecting New from the File menu displays a confirmation dialog box asking whether to save 
the project that you are currently working on. Then, you can create the project as a new project.
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4.6 Project Saving Function
This function saves the project that you have worked on.
You can save the current project by selecting Save or Save As from the File menu.  (The exten-
sion of saved files is ".iol".)
By selecting Open from the File menu, you can open any project that has been saved. 

4.7 IODD Management Function
This function enables you to import or delete IODD files.
Selecting Import IODD from the File menu displays a file selection window. Selecting a valid 
IODD file imports the file into SC-LG-CEF Configuration Tool.
The IO-Link device specified in the imported IODD file will be added to the Select Device win-
dow.
Selecting Delete IODD from the File menu displays the Select Device window.
Selecting an IO-Link device and then clicking the Delete button deletes the IODD file that con-
tains the selected IO-Link device.

Caution

	● IODD files that have been imported can be used until they are deleted.
	● Download the IODD files from the website of the IO-Link device manufacturer or the  

IODDfinder website (https://ioddfinder.io-link.com/).
	● The IODD files of Panasonic IO-Link devices can be downloaded from our website  

(https://panasonic.net/id/pidsx/global).
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4.8 Network Number Setting Function
This function sets a network number for each IO-Link master.
The Network number window is displayed when you add an IO-Link master without a network 
number or click the Network No. Setting button in the Information tab of the IO-Link master in-
formation window.

Information

In the Network number field, enter the network number that is set for the IO-Link master.

Unless the correct network number is set, the IO-Link master and IO-Link devices cannot 
be set up normally.
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4.9 Language Switching Function
This function allows you to switch the language for SC-LG-CEF Configuration Tool.
Selecting Language from the File menu enables you to switch the language between Japanese 
and English.

Information

When you have switched the language, restart SC-LG-CEF Configuration Tool.

4.10 Exit Function
This function closes SC-LG-CEF Configuration Tool.
Selecting Exit from the File menu enables you to close SC-LG-CEF Configuration Tool.
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Various confirmation dialog boxes are displayed when the user is asked for confirmation dur-
ing operation or the device enters in an inoperable state. If any message is displayed, carefully 
read the following information and check an appropriate action method.

5.1 Messages

Message Action method

IODD file is invalid
The IODD file that you attempted to import is invalid and so you can-
not import it. Contact the organization from which you obtained the 
IODD file.

The file can't be deleted because XXX is 
using

The IODD file that you want to delete is currently in use, so it cannot 
be deleted. Close the project first and then delete the file.

It failed to write the device's parameter.
An attempt to write the parameter to the IO-Link device has failed.
Check the connections.
If any error message is displayed, take action according to the mes-
sage.

Loading the setting file is failed The file required to start SC-LG-CEF Configuration Tool was not 
found. The tool will be started using the default settings.

The password you entered is incorrect Enter the same password in both password fields.

The real device and configured device 
are different

The IO-Link device set up with SC-LG-CEF Configuration Tool dif-
fers from the IO-Link device that is actually connected. Check the 
tool settings or actual connections.

The data format is wrong. The format of the entered data is incorrect. Enter data in the correct 
format.

The real device and configured device 
are different

The IO-Link device set up with SC-LG-CEF Configuration Tool dif-
fers from the IO-Link device that is actually connected. Check the 
tool settings or actual connections.

It's a same port number. For the paste target port, specify any port other than the copy source 
port.

It failed to read the port configuration. An attempt to read port settings from the IO-Link master has failed. 
Check the connections.

The password you entered is incorrect. Enter the correct password.

It failed to write the port configuration. An attempt to write port settings to the IO-Link master has failed. 
Check the connections.
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